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Data/Application iSeries Server Configuration

Once you have configured the communication link to the Data/Application Server and you have installed the LANSA for 
the Web Utilities, you are ready to configure the Data/Application Server.

Note: If you are using a single tier installation, the Web Server and the Data/Application Server are located on the same 
iSeries. The Web Server can be configured at the same time as the Data/Application Server. 

The iSeries Data/Application Server configuration task includes the following steps:

Before You Begin Checklist

Step 1. Execute the Web Administrator with iSeries Data/Application Server

Step 2. Enable iSeries Partition

Step 3a. iSeries User Registration for DFTUSR

Step 3b. Create iSeries DFTUSR

Step 4a. Configure iSeries Data/Application Server

Step 4b. Configure iSeries Data/Application Server - Miscellaneous

Step 4c. Configure - File Location (SINGLE TIER ONLY)

Step 5a. iSeries Maintain System Definition - General (SINGLE-TIER iSeries ONLY)

Step 5b. iSeries Maintain System Definition - Web Server (SINGLE-TIER ONLY)

Step 6. Test the LANSA for the Web Editor and iSeries Partition Set Up



Data/Application iSeries Server Configuration

© 2002 LANSA Extract from Installing LANSA on iSeries guide2

Before You Begin Checklist

Before you begin the single tier configuration task, check the following: 

• Do you have the QSECOFR or LANSA partition security officer profile?  

• Do you have an iSeries user profile to assign to DFTUSR for anonymous user access? For more details, refer to Web 
and iSeries User Profiles in the Installing LANSA on iSeries guide.

• Do you know which partition you will be using for LANSA for the Web? If DEM is available, it is recommended that 
you Web enable the partition.

• Have you completed the LWEBSF save file import into the partition to be used with LANSA for the Web? You cannot 
use the LANSA for the Web utilities unless the LWEBSF has been imported into the partition.

• Do you know the name of the working library to be used with LANSA for the Web? This library must already exist on 
the iSeries.

• Is the LANSA Listener active? 
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Step 1. Execute the Web Administrator with iSeries Data/Application Server

Execute the LANSA for the Web Administrator using the icon on your desktop.

Enter the System name for the Data/Application Server. (This is the Server name created in Install the LANSA for the Web 
Administrator as described in the Installing LANSA on Windows guide.)

Specify the Host Type as AS/400 using the drop down.

Enter the name of an existing Partition (such as DEM) which you wish to enable.

Enter language to be used in the partition. Leave this field blank if you are using a non-multilingual partition.

Enter the LANSA system owner or partition security officer Userid and Password. (Reminder: The iSeries user profile must 
have the LANSA program library in its library list.)

Press OK to connect to the iSeries. If you are not able to connect, refer to the Installing LANSA on Windows guide.
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Step 2. Enable iSeries Partition

Choose the Tools menu and select the Enable Partition command. 

The Enable Partition dialog will appear.

Enter the 3 character partition identifier (such as DEM) and press OK to Web enable the partition. 

This option will create the required Standard HTML pages in the partition. You should Web enable a partition only once.
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Step 3a. iSeries User Registration for DFTUSR

In this step, you will register the DFTUSR user to allow No User Authentication - Anonymous User Access to your Web 
applications. Be sure to assign the Web User ID to an iSeries0 user profile with minimal access rights.

Choose the Security menu and select the User Registration command. 

The User Registration window is displayed.

To create a new user, you can press the Add button or you can right click on the Web User ID column and select Add from 
the pop-up menu displayed. 
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Step 3b. Create iSeries DFTUSR

Press the Add button on the User Registration window to register a new user.

The Add User window is displayed.

Enter the following information (for details about any of the requested parameters, use the Help button):

Web User ID
Enter DFTUSR.

You can assign partition level user access for the anonymous user by creating users of the form DFT_<partition>. This way 
you can assign certain rights to a particular partition.

System Name
If you are not using multi-homing support, enter *DEFAULT as your System Name.

If you are using multi-homing support, enter either the DNS Name (for example: sydaspect.lansa.com) or the DNS's IP 
Address (for example: 124.54.56.21) in the System Name field.

Port Number
If you are not using multi-homing support, enter 80 for the Port Number or leave this field blank.

If you are using multi-homing support, enter the port number associated with the System Name and the Web User ID.

Timeout
Enter a timeout of 0 which means that the system wide timeout applies.

Host User ID and Password
Enter the iSeries user profile and password which the Web User ID (DFTUSR) will use on the iSeries.

The Password of the User ID in the Host User Information must match the password in the iSeries user profile. For 
example, before you can use the LANSA for the Web facilities, you need to set up the WEBUSER profile on the iSeries.

For details about the iSeries user profile, refer to Web and iSeries User Profiles in the Installing LANSA on iSeries guide.
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Step 4a. Configure iSeries Data/Application Server - Transaction Monitor

Choose the Tools menu and select the Configure System command. 

Select the Transaction Monitor tab. 

Enter the following information (for details about any of the requested parameters, use the Help button):

HTML Timeout (minutes)
Any LANSA jobs that have remained inactive after the timeout period has elapsed will be terminated by the Transaction 
Monitor.  

The default value is 5 minutes (stored as 300 seconds in the DC@LWEB data area).

XML Timeout (minutes)
Any LANSA jobs that have remained inactive after the timeout period has elapsed will be terminated by the Transaction 
Monitor.

The default value is 5 minutes (stored as 300 seconds in the DC@LWEB data area).

Purge WEBEVENT function data (hrs)
The information needed to restart WEBEVENT functions will be held for the time you specify here. When a WEBEVENT 
function has been inactive for longer than this time, the data will be deleted. This means WEBEVENT functions that have 
been inactive for up to this time limit may be restarted with no loss of data. 

The default period is 10 hours (stored in the data area in seconds).

Reset the Transaction Monitor
The Transaction Monitor is used to terminate LANSA for the Web jobs that have been dormant for a defined period of time.  
If your host is restarted, this option must be set to ‘N’ to re-activate the Transaction Monitor again. 
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Transaction Monitor checks (minutes)
The Transaction Monitor monitors all the LANSA jobs started by LANSA for the Web. It is responsible for terminating any 
jobs that have not been active after a defined period. There is only one instance of the Transaction Monitor for a given host.

The default value is 2 minutes (stored as 120 seconds in the DC@LWEB data area).

System for Transaction Monitor (iSeries host only)
Enter the job queue for jobs to be submitted to run the Transaction Monitor. By default, the Transaction Monitor will submit 
jobs to job queue QINTER.

The Transaction Monitor is identified as LWEB_MON.

This option is disabled if you are connected to a host type Other.

System for WEB Jobs (iSeries host only)
Enter the job queue to submit the LANSA for the Web jobs. By default, these jobs are submitted to the job queue QINTER.

The LANSA for the Web jobs are named as LWEB_JOB.

This option is disabled if you are connected to a host type Other.

Prestarted Web Jobs (Connections) - Minimum, Maximum, & Maximum reuse
Enter the number of times a Prestarted job can be used in the range 0-999. The default value for Maximum and Minimum is 
2. The default value for Maximum reuse is 500.
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Step 4b. Configure iSeries Data/Application Server - Miscellaneous

Select the Miscellaneous tab. 

Enter the name of the Web Working library. The default is DCXWRKLIB (For details about any of the requested 
parameters, use the Help button.)

Check the Enable Extended Exchange checkbox to allow exchange of more than 2000 bytes of data.

If you are using a Single-tier iSeries installation, go to Step 4c. Configure - File Location (SINGLE TIER ONLY).

If you are using a Multi-tier iSeries installation, go to Step 6. Test the LANSA for the Web Editor and iSeries Partition Set 
Up.
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Step 4c. Configure - File Location (SINGLE TIER ONLY) 

You will only complete this step if you are using a single-tier iSeries installation where the Web Server and 
Data/Application Server are located on the same iSeries.

Select the File location tab.

Enter:

CGI
Specify CGI-BIN as the alias used for the location of the CGI files used by the Web Server software. Note: This is not the 
name of the library containing the script files. The library names is specified in the IBM HTTP Server configuration.

The default value, provided by the I/NET Web Server/400 or Commerce Server/400 products, is ‘CGI-BIN’. This alias must 
be defined in the Web Server/400 or IBM HTTP Server for iSeries configuration. (Refer to Configuration of IBM HTTP 
Server using CGI which is on the LANSA Web site www.LANSA.com/support.)

Image Files
Specify /IMAGES as the name of the alias used for the image file locations used by LANSA for the Web. LANSA for the 
Web expects to find all the image files in a single location. Note: This is not the name of the directory on the IFS. The IFS 
directory is specified in the IBM HTTP Server configuration.

The default setting is /IMAGES. This alias, IMAGES, must be defined in the Web Server/400 or IBM HTTP Server for 
iSeries configuration. (Refer to Configuration of IBM HTTP Server using CGI which is on the LANSA Web site 
www.LANSA.com/support.)
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Authentication Library
The Authentication Library does not have to be specified unless you are using a LANSA for the Web security model which 
requires authentication. This value can be overridden by the Authentication Library specified using the Maintain System 
option. 

Press OK to complete the configuration.

If you are using a single-tier iSeries installation, go to Step 5a. iSeries Maintain System Definition - General (SINGLE-
TIER iSeries ONLY).
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Step 5a. iSeries Maintain System Definition - General (SINGLE-TIER iSeries ONLY)

Choose the Tools menu and select the Maintain System command.

A list of all the defined systems will be displayed in the Maintain System windows. (This information is stored in the 
DC@W12 file.)

Press Add to define a new system. 

Enter:

System Name
This is the system name of the iSeries Web Server.

If you are not using multi-homing support, enter *DEFAULT as your System Name.

If you are using multi-homing support, enter either the DNS Name (for example: sydaspect.lansa.com) or the DNS's IP 
Address (for example: 124.54.56.21) in the System Name field.

Port 
Enter the port used for the system. Default is 80. 
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LANSA Library
Enter the name of the LANSA program library for the system. Default is DC@PGMLIB.

Partition
Specify the partition only if you want to have all the requests for that port use a particular LANSA partition. If a partition is 
specified, it will override any partition specified in the URL. If no partition is specified, you must specify the partition
parameter in your URL.

Spool File Access (HTML mode only)
Select an entry from the drop down list to set the level of user access to view iSeries Spool files via LANSA for the Web. 
Spool File Access is disabled in XML mode.

Secured Sockets Layer (SSL) Support
Select this option if you want to enable SSL for this system.

Server Side Include (SSI) Support
Select this option if you want to enable SSI support for this system.  Make sure that your Web serving product is capable of 
supporting this feature before enabling this option.

Send specified HTTP Header Variable values to the host
Select this option if you want to send the values for the specified HTTP Header Variables to the host, i.e. the 
Data/Application Server. To specify these HTTP Header Variables to be sent, select the Tools menu and choose the HTTP 
Header Variables command.

If you are using a single-tier iSeries installation, go to Step 5b. iSeries Maintain System Definition - Web Server (SINGLE-
TIER ONLY).
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Step 5b. iSeries Maintain System Definition - Web Server (SINGLE-TIER ONLY) 

You will only complete this step if you are using a single tier iSeries installation where the Web Server and 
Data/Application Server are located on the same iSeries.

Select the Web Server tab.

Use the Web Server drop down and select IBM ICS if you are using the IBM HTTP Server.

Enter:

Web Server
Select the appropriate Web serving product from the drop down list.

Host and Client CCSID
If you are using IBM’s HTTP Server for iSeries as your Web Server, you will need to provide the host and client CCSIDs. 
These CCSIDs are used for data translation purposes.

iSeries CGI Library and iSeries Authentication Library
If the Web Server drop down value is changed, you may use the copy option. If you enter the iSeries libraries for the CGI 
script and authentication programs, the installed programs will be copied to specified libraries. The libraries specified must 
already exist on the iSeries. You do not need to copy the CGI script programs unless you are using authentication for the 
system. For more details, refer to Partial User Authentication - Process Level Security

Press OK to complete the configuration.
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Step 6. Test the LANSA for the Web Editor and iSeries Partition Set Up

Start the LANSA for the Web Editor from the icon on your desktop and connect to the Data/Application Server. 

Enter the required profile and password information.

In the LANSA for the Web Editor, use the File menu and select Open option. 

A list of the current HTML pages in your partition should be displayed. 

Check that the page DEFAULT_SCRIPT is in the list. If this page is not listed, than the partition has not been Web enabled. 
Refer to Step 2. Enable iSeries Partition.

If the page appears, the LANSA for the Web Utilities are operating correctly and the partition is properly configured.

Exit from the LANSA for the Web Editor.

The Configure iSeries Data/Application Server task is now complete.
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